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Are	
  you…	
  

•  An	
  explorer?	
  
–  Learning	
  about	
  
Photoshop	
  for	
  the	
  
1st	
  %me	
  

•  A	
  vaca%oner?	
  
–  Familiar	
  with	
  
Photoshop	
  

•  A	
  prisoner?	
  
–  Your	
  supervisor	
  
forced	
  you	
  to	
  be	
  
here.	
  



How	
  many	
  %ps	
  &	
  tricks	
  in	
  60	
  
minutes?	
  

•  Tip	
  #1	
  –	
  Don’t	
  
promise	
  60	
  %ps	
  
in	
  60	
  minutes	
  or	
  
less	
  (Just	
  
kidding!)	
  



1.	
  Follow	
  Tutorials	
  

•  Tutorial9	
  
•  PS	
  Hero	
  
•  Tutzor	
  
•  PhotoshopStar	
  
•  Tutorial	
  Dog	
  
•  Abduzeedo	
  
•  PhotoshopGUIDesign	
  

•  Worth1000	
  
•  Digital	
  Grin	
  
•  Photoshop	
  Support	
  
•  PSD	
  Learning	
  
•  PSDFAN	
  
•  PhotoshopTutorials.ws	
  
•  Photoshop	
  Essen%als	
  	
  



2.	
  Experiment	
  

Free	
  form	
  
experimenta%on	
  
can	
  open	
  up	
  
your	
  crea%vity	
  
and	
  help	
  you	
  to	
  
get	
  more	
  
comfortable	
  
with	
  Photoshop.	
  	
  



3.	
  Rule	
  of	
  Thirds	
  



4.	
  Start	
  with	
  Fundamentals	
  	
  

•  Adobe	
  Classroom-­‐in-­‐
a-­‐Book	
  series	
  

•  Ask	
  your	
  high	
  school/
community	
  college.	
  

•  Check	
  your	
  local	
  
library.	
  



5.	
  Web	
  vs.	
  Print	
  

•  Web	
  	
  
– 72	
  dpi/resolu%on	
  
– RGB	
  

•  Print	
  
– 300+	
  dpi/resolu%on	
  
– CMYK	
  



6.	
  Typography	
  

Times New Roman 
	
  

Arial 

• Serif	
  (print)	
  vs.	
  Sans	
  Serif	
  (web,	
  billboard)	
  
• Bemer	
  to	
  add	
  text	
  outside	
  Photoshop	
  
(pixelated)	
  



7.	
  Step	
  One:	
  Adjustments	
  	
  

•  Brightness/Contrast	
  
•  Levels	
  
•  Curves	
  
•  Exposure	
  
•  Vibrance	
  
•  Hue/Satura%on	
  
•  Color	
  Balance	
  



8.	
  Auto	
  
Adjust	
  



9.	
  255	
  Shades	
  of	
  Black	
  (Levels)	
  



10.	
  Contras%ng	
  Color	
  

•  Boos%ng	
  the	
  contrast	
  
in	
  a	
  color	
  photo	
  can	
  
produce	
  some	
  
stunning	
  results.	
  	
  

•  Bump	
  up	
  the	
  contrast,	
  
play	
  with	
  the	
  colors,	
  
and	
  add	
  that	
  sort	
  of	
  
“grunge”	
  mood	
  to	
  
your	
  photo.	
  



11.	
  Contras%ng	
  B&W	
  

•  Boos%ng	
  contrast	
  on	
  black	
  &	
  white	
  creates	
  a	
  
focus	
  on	
  the	
  shapes,	
  lines,	
  and	
  pamerns	
  rather	
  
than	
  the	
  tones.	
  	
  



12.	
  Curves	
  



13.	
  Satura%on	
  

•  One	
  way	
  to	
  make	
  your	
  photo	
  “pop”	
  is	
  to	
  really	
  
push	
  up	
  the	
  color	
  satura%on.	
  	
  



14.	
  Unsharp	
  Mask	
  

•  A.K.A.	
  haze	
  curng,	
  HIRALOAM,	
  or	
  local	
  	
  
contrast	
  enhancement	
  

•  This	
  technique	
  involves	
  using	
  the	
  Unsharp	
  	
  
Mask	
  filter	
  at	
  a	
  low	
  amount	
  and	
  high	
  radius	
  	
  
to	
  increase	
  tonal	
  transi%ons	
  between	
  	
  
adjacent	
  pixels.	
  

	
  	
  
1.  Merge	
  all	
  your	
  visible	
  layers	
  into	
  a	
  new	
  layer	
  	
  

(Mac:	
  ShiX-­‐Alt-­‐Apple-­‐E,	
  PC:	
  Ctrl-­‐ShiX-­‐Alt-­‐E	
  (I	
  think))	
  
2.  Select	
  the	
  new	
  layer	
  and	
  open	
  the	
  Unsharp	
  Mask	
  filter.	
  
3.  Set	
  the	
  Amount	
  to	
  20,	
  the	
  Radius	
  to	
  50	
  and	
  the	
  Threshold	
  to	
  0.	
  
4.  Change	
  the	
  layer	
  style	
  to	
  “Luminosity’	
  to	
  prevent	
  any	
  color	
  shiXs.	
  
5.  Pull	
  the	
  layer	
  opacity	
  down	
  to	
  suit	
  and/or	
  add	
  a	
  mask	
  to	
  localize	
  the	
  

effect.	
  



15.	
  Sharp	
  

•  Most	
  photos	
  need	
  to	
  
be	
  sharpened	
  anyways,	
  
but	
  some	
  photos	
  can	
  
actually	
  benefit	
  from	
  
oversharpening.	
  This	
  
method	
  gives	
  the	
  
image	
  a	
  “harder”	
  look	
  
and	
  feel.	
  



16.	
  Hidden	
  Op%ons	
  

•  There	
  are	
  hidden	
  op%ons	
  behind	
  %ny	
  arrows	
  
on	
  almost	
  every	
  tool	
  bard	
  in	
  Adobe	
  Suite.	
  



17.	
  Brush	
  Tool	
  



18.	
  Cloning	
  	
  
(Zits,	
  not	
  sheep)	
  

•  Alt	
  +	
  Click	
  to	
  clone	
  
•  Click	
  to	
  paste	
  



19.	
  Dodging	
  &	
  Burning	
  

•  Dodging	
  and	
  burning	
  is	
  a	
  technique	
  carried	
  over	
  
from	
  darkroom	
  days.	
  	
  

1.  Hold	
  Alt	
  and	
  click	
  the	
  ‘New	
  Layer’	
  bumon	
  on	
  the	
  
Layers	
  paleme.	
  

2.  Change	
  the	
  blending	
  mode	
  to	
  ‘Overlay’	
  and	
  click	
  
the	
  box	
  ‘Fill	
  with	
  Overlay-­‐neutral	
  color’.	
  

3.  Duplicate	
  this	
  layer,	
  and	
  name	
  one	
  of	
  them	
  ‘Burn’	
  
and	
  the	
  other	
  ‘Dodge’.	
  	
  

4.  Using	
  a	
  low	
  opacity	
  brush	
  (5-­‐15%)	
  paint	
  with	
  
black	
  onto	
  the	
  ‘Burn’	
  layer	
  to	
  darken	
  things,	
  and	
  
with	
  white	
  on	
  the	
  ‘Dodge	
  layer’	
  to	
  lighten	
  things	
  
–	
  effec%vely	
  increasing	
  contrast.	
  	
  

•  Key	
  point:	
  Dodging	
  and	
  burning	
  will	
  only	
  help	
  to	
  
exaggerate	
  tonal	
  differences	
  already	
  present	
  in	
  the	
  
image,	
  it	
  can’t	
  make	
  something	
  out	
  of	
  nothing.	
  



20.	
  Filters	
  
Friend	
  or	
  Foe?	
  



21.	
  Clouds	
  

•  Set	
  
foreground/	
  
background	
  
colors	
  first	
  

•  “Render”	
  in	
  a	
  
new	
  layer	
  



22.	
  Texturize	
  

•  Overlay	
  texture	
  to	
  
bring	
  in	
  subtle	
  
elements	
  to	
  your	
  
image.	
  It’s	
  a	
  great	
  way	
  
to	
  deal	
  with	
  flat	
  and	
  
bland	
  por%ons	
  of	
  the	
  
photo	
  by	
  introducing	
  
detail	
  and	
  complexity	
  
into	
  it.	
  



23.	
  Noise	
  &	
  Grain	
  
•  This	
  is	
  another	
  way	
  to	
  spice	
  up	
  the	
  bland	
  
parts	
  of	
  your	
  image.	
  Adding	
  noise	
  or	
  
simulated	
  grain	
  adds	
  texture	
  and	
  feeling	
  
to	
  a	
  photo,	
  and	
  can	
  some%mes	
  produce	
  
very	
  “grimy”	
  results.	
  



24.	
  Vigneme	
  

•  Some	
  images	
  really	
  stand	
  
out	
  with	
  some	
  applied	
  
vigneme.	
  It	
  helps	
  create	
  a	
  
natural	
  frame	
  around	
  the	
  
image	
  and	
  it	
  draws	
  the	
  eye	
  
toward	
  the	
  center	
  of	
  the	
  
photo.	
  



25.	
  High	
  Pass	
  Filter	
  

•  Duplicate	
  the	
  layer	
  and	
  go	
  to	
  Filter>Other>High	
  Pass.	
  
Use	
  5	
  pixels.	
  Then	
  change	
  the	
  Blend	
  Mode	
  of	
  the	
  layer	
  
to	
  Hard	
  Light.	
  Duplicate	
  the	
  High	
  Pass	
  layer.	
  Keep	
  the	
  
blend	
  mode	
  with	
  Hard	
  Light.	
  

•  Duplicate	
  the	
  original	
  photo	
  and	
  change	
  its	
  Blend	
  
Mode	
  to	
  Screen.	
  Then	
  with	
  the	
  Eraser	
  Tool	
  (E)	
  or	
  with	
  
a	
  Mask.	
  Delete	
  the	
  dark	
  areas	
  of	
  the	
  photo.	
  Leave	
  just	
  
the	
  light	
  areas,	
  the	
  eyes,	
  nose,	
  and	
  mouth.	
  	
  

•  Group	
  all	
  layers	
  and	
  convert	
  them	
  to	
  Smart	
  Objects,	
  
Layers>Smart	
  Objects>Convert	
  to	
  Smart	
  Objects.	
  	
  





26.	
  Overlay	
  Photo	
  On	
  Text	
  

•  Drop	
  an	
  image	
  layer	
  over	
  a	
  type	
  layer	
  then	
  
hold	
  down	
  Alt	
  and	
  click	
  the	
  line	
  between	
  the	
  
two	
  layers	
  in	
  the	
  Layers	
  Panel	
  to	
  clip	
  the	
  
image	
  to	
  the	
  text.	
  



27.	
  Refining	
  a	
  Selec%on	
  

•  AXer	
  you	
  make	
  a	
  selec%on	
  in	
  Photoshop	
  you	
  
can	
  easily	
  edit	
  the	
  selec%on	
  using	
  refine	
  edge	
  in	
  
the	
  top	
  toolbar.	
  	
  



28.	
  Blending	
  

•  Right	
  click	
  a	
  layer	
  in	
  the	
  layers	
  toolbar	
  and	
  
click	
  “blending	
  op%ons”	
  for	
  an	
  array	
  of	
  effects.	
  



Blending…	
  

•  If	
  you	
  can	
  master	
  blending	
  
modes	
  in	
  Photoshop,	
  you	
  
“own”	
  it.	
  Open	
  up	
  the	
  layers	
  
paleme,	
  select	
  a	
  layer	
  and	
  
click	
  the	
  downwards	
  arrow	
  
where	
  it	
  says	
  Normal.	
  Try	
  
experimen%ng	
  with	
  different	
  
blending	
  modes	
  on	
  different	
  
layers,	
  put	
  layers	
  above	
  or	
  
below	
  other	
  layers,	
  change	
  
the	
  opacity	
  and	
  so	
  fourth	
  
and	
  you	
  will	
  be	
  amazed!	
  



29.	
  Resist	
  the	
  Filter	
  

•  Do	
  not	
  use	
  the	
  
filter	
  gallery	
  
unless	
  you	
  know	
  
how	
  to	
  use	
  it	
  well	
  
or	
  for	
  an	
  effect	
  
that	
  you	
  need.	
  	
  
Resist	
  adding	
  lens	
  
flare,	
  rainbow	
  
gradients,	
  
embossed	
  type	
  
and	
  drop	
  shadow.	
  

“15	
  Signs	
  You’re	
  a	
  Bad	
  Graphic	
  Designer”	
  
hmp://justcrea%ve.com/2007/12/06/bad-­‐graphic-­‐design/	
  

	
  



30-­‐34.	
  Shortcut	
  Commands	
  

•  ]	
  and	
  [	
  Change	
  your	
  brush	
  %p	
  size	
  
•  Cmd/Ctrl+J	
  Duplicate	
  a	
  layer	
  or	
  selec%on	
  
•  Space	
  Bar	
  Hold	
  Space	
  and	
  drag	
  to	
  navigate	
  
around	
  the	
  image	
  

•  TAB	
  Hides	
  or	
  shows	
  all	
  panels	
  and	
  tools	
  
•  Cmd/Ctrl+T	
  Transform	
  a	
  layer	
  



35-­‐39.	
  Shortcut	
  Commands	
  

•  Cmd/Ctrl+E	
  Merge	
  selected	
  layer	
  down,	
  or	
  
merges	
  several	
  highlighted	
  layers	
  

•  Cmd/Ctrl/Ctrl+ShiN+Opt+S	
  Save	
  for	
  web	
  &	
  
devices	
  

•  Cmd/Ctrl+L	
  Bring	
  up	
  levels	
  box	
  
•  Cmd/Ctrl+T	
  Open	
  Free	
  Transform	
  tool	
  
•  Cmd/Ctrl+M	
  Open	
  Curves	
  



40-­‐44.	
  Shortcut	
  Commands	
  

•  Cmd/Ctrl+B	
  Edit	
  Colour	
  Balance	
  
•  Cmd/Ctrl+ShiN+Opt+C	
  Scale	
  your	
  image	
  to	
  
your	
  preferred	
  state	
  

•  Cmd/Ctrl+Opt+G	
  Create	
  clipping	
  mask	
  
•  Cmd/Ctrl+0	
  Fit	
  on	
  screen	
  
•  Cmd/Ctrl+ShiN+>/<	
  Increase/decrease	
  size	
  of	
  
selected	
  text	
  by	
  2pts	
  



45-­‐49.	
  Shortcut	
  Commands	
  

•  Cmd/Ctrl+OpRon+ShiN-­‐>/<	
  Increase/decrease	
  
size	
  of	
  selected	
  text	
  by	
  10pts	
  

•  ]/[	
  Increase/decrease	
  brush	
  size	
  
•  ShiN+F5	
  Fill	
  the	
  selec%on	
  
•  }/{	
  Increase/decrease	
  brush	
  hardness	
  
•  ,/.	
  previous/next	
  brush	
  



50-­‐54.	
  Shortcut	
  Commands	
  

•  </>	
  First/last	
  brush	
  
•  Cmd/Ctrl+]	
  Bring	
  layers	
  forward	
  
•  Cmd/Ctrl+[	
  Send	
  layer	
  back	
  
•  Cmd/Ctrl+ShiN+[	
  Send	
  layer	
  to	
  bomom	
  of	
  
stack	
  

•  Cmd/Ctrl+ShiN+]	
  Bring	
  layer	
  to	
  bomom	
  of	
  
stack	
  



55-­‐59.	
  Shortcut	
  Commands	
  

•  You	
  probably	
  know	
  that	
  Cmd/Ctrl+Z	
  is	
  Undo,	
  but	
  
you	
  may	
  not	
  know	
  Cmd/Ctrl+Alt+Z	
  lets	
  you	
  undo	
  
more	
  than	
  one	
  history	
  state.	
  

•  Cmd/Ctrl+ShiN+Alt+E	
  will	
  merge	
  a	
  copy	
  of	
  all	
  
Layers	
  

•  F	
  Cycle	
  through	
  workspace	
  backgrounds	
  
•  X	
  Change	
  your	
  foreground	
  and	
  background	
  colors	
  
•  D	
  Reset	
  foreground	
  and	
  background	
  colors	
  to	
  
black	
  and	
  white	
  

	
  



60-­‐62.	
  Shortcut	
  Commands	
  

•  Name	
  your	
  layers	
  –	
  Double-­‐click	
  and	
  type.	
  
•  Use	
  color	
  coding	
  to	
  organize	
  your	
  Layers	
  
Panel.	
  Right-­‐click	
  over	
  a	
  layer’s	
  eye	
  icon	
  to	
  
quickly	
  access	
  8	
  color	
  code	
  choices.	
  

•  Close	
  all	
  images	
  at	
  once	
  -­‐	
  ShiN-­‐click	
  any	
  
image	
  window’s	
  close	
  icon.	
  



63-­‐65.	
  Shortcut	
  Commands	
  

•  Interac%ve	
  zooming	
  -­‐	
  Hold	
  Cmd/Ctrl+Space	
  then	
  drag	
  
right	
  to	
  zoom	
  in,	
  or	
  leX	
  to	
  zoom	
  out.	
  The	
  zoom	
  targets	
  
where	
  your	
  mouse	
  icon	
  is,	
  so	
  it’s	
  one	
  of	
  the	
  quickest	
  
ways	
  to	
  navigate	
  around	
  an	
  image.	
  

•  Bird’s	
  Eye	
  View	
  -­‐	
  When	
  zoomed	
  in	
  close,	
  hold	
  down	
  H	
  
and	
  drag	
  in	
  the	
  image	
  to	
  instantly	
  dart	
  out	
  to	
  full	
  
screen	
  then	
  jump	
  back	
  to	
  another	
  area.	
  

•  Backgrounds	
  -­‐	
  Want	
  to	
  change	
  the	
  default	
  grey	
  
background	
  to	
  something	
  more	
  funky?	
  ShiN–click	
  over	
  
the	
  background	
  area	
  with	
  the	
  Paint	
  Bucket	
  tool	
  to	
  fill	
  it	
  
with	
  your	
  foreground	
  color.	
  Right-­‐click	
  it	
  to	
  go	
  back	
  to	
  
grey.	
  



	
  	
  	
  66-­‐69.	
  Shortcut	
  Commands	
  

•  Hirng	
  Tab	
  hides	
  all	
  of	
  your	
  palemes.	
  Hirng	
  
Tab	
  again	
  brings	
  them	
  back.	
  

•  ShiX+Tab	
  hides	
  all	
  the	
  palletes	
  except	
  your	
  
toolbar.	
  	
  

•  Hirng	
  the	
  "D"	
  key	
  resets	
  your	
  color	
  pallets	
  to	
  
Black	
  foreground,	
  White	
  Background.	
  	
  

•  The	
  "X"	
  key	
  will	
  toggle	
  your	
  foreground	
  and	
  
background	
  colors.	
  	
  

	
  
	
  
	
  



•  Use	
  CMD+Delete	
  to	
  fill	
  your	
  layer	
  or	
  selec%on	
  
with	
  the	
  current	
  background	
  color.	
  	
  

•  Op%on+Delete	
  fills	
  your	
  layer	
  or	
  selec%on	
  with	
  
the	
  foreground	
  color.	
  	
  

•  Change	
  your	
  paintbrush	
  circle	
  into	
  a	
  crosshair	
  
for	
  precise	
  control	
  by	
  pressing	
  the	
  Caps	
  Lock	
  
key.	
  	
  

	
  	
  	
  70-­‐72.	
  Shortcut	
  Commands	
  



	
  	
  73-­‐75.	
  Shortcut	
  Commands	
  

•  Double-­‐Click	
  the	
  ruler	
  on	
  the	
  top	
  or	
  side	
  of	
  your	
  
document	
  brings	
  up	
  the	
  Units	
  &	
  Ruler	
  Dialogue	
  
box.	
  (handy	
  if	
  you	
  work	
  in	
  both	
  print	
  and	
  web	
  

•  To	
  quickly	
  change	
  the	
  blend	
  mode	
  of	
  a	
  layer	
  ShiX
+Op%on+(lemer	
  corresponding	
  to	
  mode)	
  ie:	
  ShiX
+Op%on+M	
  is	
  Mul%ply.	
  ShiX+Op%on+V	
  is	
  Vivid	
  
Light.	
  	
  

•  Using	
  ShiX+	
  the	
  "+"	
  or	
  "-­‐"	
  will	
  toggle	
  through	
  the	
  
various	
  blend	
  modes	
  one	
  at	
  a	
  %me.	
  	
  



	
  	
  76-­‐77.	
  Shortcut	
  Commands	
  

•  Double-­‐click	
  the	
  Background	
  Layer	
  and	
  hit	
  OK	
  
to	
  convert	
  it	
  to	
  an	
  editable	
  layer	
  

•  A	
  new	
  layer	
  filled	
  with	
  50%	
  grey	
  is	
  useful	
  in	
  
lots	
  of	
  situa%ons.	
  For	
  example,	
  you	
  can	
  dodge	
  
and	
  burn	
  with	
  it,	
  add	
  texture,	
  or	
  manipulate	
  a	
  
Lens	
  Flare	
  effect,	
  all	
  in	
  a	
  completely	
  non-­‐
destruc%ve	
  way.	
  To	
  create	
  a	
  50%	
  grey	
  layer,	
  
make	
  a	
  new	
  layer	
  then	
  go	
  to	
  Edit>Fill,	
  then	
  set	
  
the	
  Blend	
  Mode	
  to	
  Overlay.	
  



	
  	
  78.	
  Quick	
  Masking	
  

•  You	
  may	
  be	
  familiar	
  with	
  Color	
  Range	
  in	
  the	
  
Select	
  drop-­‐down	
  menu.	
  But	
  did	
  you	
  know	
  
that	
  you	
  can	
  access	
  a	
  similar	
  command	
  
through	
  the	
  Color	
  Range	
  bumon	
  in	
  the	
  Masks	
  
Panel?	
  (Window>Masks).	
  This	
  allows	
  you	
  to	
  
quickly	
  make	
  a	
  mask	
  by	
  sampling	
  colors,	
  
which	
  can	
  be	
  used	
  for	
  making	
  a	
  quick	
  spot	
  
color	
  effect.	
  



	
  	
  79.	
  Copy	
  in	
  Fire	
  

•  Open	
  a	
  portrait	
  image	
  
and	
  a	
  generic	
  fire	
  
image,	
  then	
  grab	
  the	
  
Move	
  tool	
  and	
  check	
  
Auto-­‐Select	
  Layer	
  and	
  
Show	
  Transform	
  
Controls.	
  Drag	
  the	
  fire	
  
image	
  into	
  the	
  girl	
  
image	
  to	
  copy	
  it	
  in,	
  
then	
  change	
  the	
  Blend	
  
Mode	
  of	
  the	
  layer	
  to	
  
Screen.	
  



80.	
  Best	
  Tip	
  –	
  Prac%ce!	
  

•  Tutorials	
  
•  Video	
  
•  Experimen%ng	
  
•  Classroom-­‐in-­‐a-­‐Book	
  



My	
  favorite	
  Photoshop	
  
Prince	
  Charles	
  &	
  Honey	
  Boo-­‐Boo	
  



Great	
  resources!	
  

•  120	
  Photoshop	
  Tips	
  
•  hmp://www.crea%vebloq.com/photo-­‐edi%ng/photoshop-­‐

%ps-­‐and-­‐fixes-­‐612316	
  

•  hmp://www.photoshopsupport.com/tutorials/
cb/%ps-­‐and-­‐tricks-­‐1.html	
  

•  41	
  Nicest	
  Photoshop	
  Effects	
  
– hmp://www.hongkiat.com/blog/41-­‐nicest-­‐
photoshop-­‐photo-­‐effects-­‐photoshop-­‐tutorials/	
  





To	
  download	
  this	
  presenta%on,	
  visit:	
  
www.cisd.org/kris%nz	
  

	
  
	
  
	
  
	
  
	
  

or	
  visit	
  TSPRA’s	
  Document	
  Vault	
  
aXer	
  the	
  conference.	
  


